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New in this Release 
This section lists the enhancements for this release of EAS. 
 

New in EAS 6.4.1 
The following enhancements are included in EAS 6.4.1. 

 Added support for Windows 8. 
 Added support for Windows Server 2012. 
 Added support for Microsoft Exchange 2010 SP3. 
 Due to changes in Exchange, information about Mail Users must be 

accessed using LDAP. With this change, the following settings must be 
configured in the EAS Admin. 

 Settings > EAS Options > View > Exchange LDAP Settings 

 Settings > EAS Options > Parent Specific > Exchange LDAP Settings 
 

New in EAS 6.4.0.4 
The following enhancements are included in EAS 6.4.0.4. 

 Added support for Exchange 2010 SP2. [178216] 
 Updated the EAS Indexer. 

 Support KeyView 10.16, which includes support for .zipx files.  

 Added a configuration to have the indexer log roll over to a new file 
when the file reaches a defined size. The original log file is renamed 
and a new file is created. [179289] 

To set the indexer log file size so that the file will rollover to a new file, 
add the following parameter to the [FULLTEXT] section of EAS.ini, 
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replacing maxSizeInKB with the desired maximum file size (in KB) for 
the indexer log 

LogSize=maxSizeInKB 

If LogSize does not exist in the [FULLTEXT] section of EAS.ini , or 
if LogSize=-1, there is no maximum file size for the indexer log and 
the log file continues to grow with no rollover. 

 Added a configuration to disable the internal stub verification when 
forwarding message attachments in Outlook Web Access (OWA). If you do 
not use the stubbing feature, disabling stub verification may positively 
impact OWA performance. [179148] 

To disable the internal stub verification, add the following parameter to the 
[owa] section of EAS.ini. 

NonStub=1 

If NonStub does not exist in the [owa] section of EAS.ini , or if 
NonStub=0, the stub check occurs (default functionality). 

 Added a new utility--EAS DB Monitor--that monitors the EAS database 
connection status. [169146] 

EAS DB Monitor must be installed on the same physical machine as the 
EAS Server.  

 Only a single instance of EAS DB Monitor is supported per EAS Server 
host machine. 

 EAS DB Monitor should be applied to all children and parents. 

 EAS DB Monitor requires read access to EAS.ini to retrieve the 
database connection string. If database connection information is not 
found, EAS DB Monitor does not start. 

EAS DB Monitor can be run in dual mode: Windows service and Windows 
task tray notify application.  

 If EAS DB Monitor is installed and started as a Windows service, it 
runs in the background and continually checks the EAS database 
connection status. It will stop EAS Service if it detects that the EAS 
database is disconnected; and then restart when detects that the 
database is reconnected. 

 If EAS DB Monitor is installed and started as a Windows task tray 
notify application (with parameter "-i", for "interface"), a task tray icon 
will be displayed and shows one of several icons to represent the EAS 
database connection status. "Balloon" notifications display when the 
database connection status changes. The EAS Service is stopped and 
restarted as appropriate. 

 Both modes generate a log file (EASDBMonitor.log) in the 
designated path. The file path is defined by setting the 
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OutputLogLocation parameter in the [EASDBMonitor] section of 
EAS.ini.  

If OutputLogLocation is not defined, EASDBMonitor.log is 
created in the working directory--C:\Windows\System32 when 
installed as a Windows Service and the install directory when installed 
as a Windows task tray notification application. 

 Added the timestamp to the search results for the EAS Outlook Add-in and 
EAS Client. This is consistent with the EAS Web Client. [178887] 

 Updated the EAS Outlook Add-in to hide buttons, instead of dimming, for 
actions not available. [179191] 

 Added a registry key on the client machine to set the log file location for 
the EAS Client and EAS Outlook Add-in. [147127] 

Under HKEY_LOCAL_MACHINE\SOFTWARE\EDUCOM TS\EASEXT, set 
LogFilePath and DebugLevel. 

Example: 
LogFilePath= C:\Program Files\ZANTAZ\EAS Outlook 
Addin\EASOutlookAddin.log 
DebugLevel =8 

 Added a configuration to specifically define the LDAP domain for use with 
EAS Outlook Web Access when a user in one domain has the same 
sAMAccountName as another user in a second domain. This assists with 
Searches. 

To specifically define the LDAP domain, add the following parameter to the 
[owa] section of EAS.ini replacing fully qualified domain as 
appropriate. 

UsingLDAPSearch=LDAP://fully qualified domain 

 Enhanced Exchange PowerShell configuration for Exchange 2010. If 
running an EAS instance on Exchange 2010 with a large amount of 
process threads, further configuration is needed to avoid performance 
issues when running Quota Archive Tasks. This configuration is related to 
Exchange PowerShell Concurrency Throttling. [179358] 

To configure Exchange 2010 PowerShell for optimum performance 
related Quota Archive Tasks 

1. Increase the PowerShell Max Concurrency limit by running the 
following command in the Exchange Management Shell. 

Set-ThrottlingPolicy [EAS user throttling policy 
name] -PowershellMaxConcurrency [new limit] 

The EAS user’s throttling policy can be obtained by running the 
following command. 

((Get-Mailbox [EAS Username]).ThrottlingPolicy | 
Get-ThrottlingPolicy).Name.  
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If the EAS user's throttling policy is the default throttling policy, 
(DefaultThrottlingPolicy_(GUID)), a new policy can be created and 
then applied to the EAS account by running the following commands.  

New-ThrottlingPolicy -Name [new policy name]-
PowerShellMaxConcurrency [new max value]  

Set-Mailbox "[EAS user name]" -ThrottlingPolicy [new 
policy name] 

2. Restart IIS on the Exchange server. 
 

New in EAS 6.4.0.2 
The following enhancements are included in EAS 6.4.0.2. 

 Support for Exchange 2010 SP2. 
 File searching performance improvements. [177005] 
 Enhancements to the EAS for Exchange Addin restore button functionality 

to include a visual progress bar. Additionally, when multiple messages are 
selected, messages are restored one at a time. These enhancements 
mimic the restore button functionality of the client. [177680] 

 

New in EAS 6.4 
The following enhancements are included in EAS 6.4. 
 

Enhanced Archive Processing in EAS for Notes 
In this release of EAS, the Notes email archive process logic is enhanced to 
archive large emails ranging from 100MB to 700MB. 

As part of this enhancement, the split attachment feature is not supported in 
EAS 6.4.  If you are currently using the split attachment feature you should not 
upgrade to EAS 6.4. To verify you are not using the split attachment feature, 
the "Archive Notes Msg Attachments As Files" setting located in the EAS UI 
under "Settings > Options > EAS Options > Lotus Notes tab should be turned 
off.. 

IMPORTANT  If you are currently using the split attachment feature with EAS 
for Notes, do not upgrade to this release. 

To fully support the enhanced archive processing, you must Install the IBM hot 
fix (852FP1SHF39_W32_standard.exe) that resolves a Lotus Notes issues in 
the export routine for large emails. This hot fix should be applied on top of 
Lotus Notes 8.5.2. 
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Enhanced Restore and Retrieve Processing 
In this release of EAS, the Notes message restore and retrieval processing is 
enhanced. Previously, when messages were restored from a stub, the stub 
was deleted from the user mailbox and the original message was re-imported 
from the database. Since all user modifications (such as flags or priority 
settings) are stored in the stub and not the database, the restored message 
did not contain the user's modifications. With this enhancement, archived 
messages are downloaded to a temporary database, zantaz.nsf, that resides 
on the end-user's machine. When a message is restored, it is reconstructed 
from this temporary database and is placed in the user mail box, with the 
user's modifications in place. If the stub is deleted in the user mail box, 
archived mail is directly imported to the user mail box from the temporary 
database. 

The zantaz.nsf temporary database must be manually created and will 
then be located in the Zantaz installation directory under the Notes data 
directory.  

C:\Program Files\IBM\Lotus\Notes\Data\zantaz\zantaz.ntf 
 

Create the zantaz.nsf Database 
The zantaz.nsf database is a temporary database that is created on the 
machine of EAS for Notes end users. This database is used to enhance the 
restoration and retrieval of stubbed messages. 

The database creation process involves an administrator creating an email 
that contains the necessary code to create the database. This email is then 
sent to EAS for Notes end users who execute the action to create the 
database. 

To create the zantaz.nsf database 

1. In the Notes client, compose a new email by selecting File > New > 
Message. 

2. In the To field, add all EAS for Notes end users. 

Complete the Subject field as desired. 
3. Click in the body of the message to focus the cursor in the message body. 

4. In the Notes menu, select Create > Hotspot > Button. 

The Button dialog opens and the button detail pane opens below the 
message body. 

5. In the Label field of the Button dialog, type Create Zantaz database (or 
other descriptive wording). 

6. In the button detail pane, select Client in the first Run dropdown list, and 
select LotusScript in the second dropdown list. 
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In the text field, type the following text between the two default LotusScript 
lines of code (between "Sub Click(Source As Button)" and "End Sub"). 
Dim strServerName As String 
Dim strTemplateName As String               
Dim strLocalName As String 
 
' Enter the servername where zantaz.ntf file resides. 
strServerName = "Interwoven/Interwoven" 
 
' zantaz.ntf file should be in data folder 
strTemplateName = "zantaz.ntf" 
 
'The local filename and directory has to be the following string. 
strLocalName = "zantaz\zantaz.nsf" 
 
Dim template As New NotesDatabase( strServerName, strTemplateName ) 
 
Dim zantazDb As NotesDatabase 
 
' First parameter is null ("") because we want to create zantaz.nsf 
in the local machine. 
Set zantazDb = template.CreateFromTemplate( "", strLocalName, True 
) 
 
' Title of the database 
zantazDb.Title = "Zantaz" 
 
' Give manager as access level 
Call zantazDb.GrantAccess("-Default-", ACLLEVEL_MANAGER) 
 
Msgbox "Completed successfully" 

7. Close the button dialog and click in the body of the message to focus the 
cursor in the message body. 

8. Add desired text to the email to instruct the user to click the button to 
create the database, and send the email. 

 

Enhanced Notes Templates 
The following enhancements have been made to the Notes 8.0 and 8.5 
templates. 

 Java library for 6.5 is removed from the script library. 
 When user restores an email it will be imported directly into the mail 

database and merged with stubs 
 When user retrieves an email, the archived email will be downloaded to a 

temporary database (zantaz.nsf). When the email is viewed it is compiled 
from the temporary database. 

 Restore and Retrieve large files (120 MB and more) is fixed. 
 Removed some of the string manipulations. 
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NSF Mail Quota 
In this release of EAS, the NSF mail quota is taken into consideration when a 
user initiates a message restore. The restore process now checks the NSF 
mail quota for the mailbox. If the restoration results in the mailbox remaining 
under the mail size quota, the message is restored. If the restoration results in 
the mailbox exceeding the mail size quote, the import is skipped and an error 
is logged. Notes notifies end users when they have reached their mail quota. 

The NSF mail quota is set up in the Domino Admin client. Select the Files tab 
and then select the desired user mail database. Set the mail quota in the 
Quotas section. 
 

Execution Control List Settings 
By default, the Lotus Notes client security settings prevent EAS for Lotus 
Notes from performing key actions. The Execution Control List (ECL) 
determines the security settings for all actions performed by the Notes client. 
The ECL lists the signatures of trusted authors of active content. 

The ECL must be configured on the Parent/Child Notes clients to include all 
EAS entities that will interact with Notes/Domino 

NOTE  These ECL settings can be configured on each client (as described 
below), or you can use the Domino Administration application to define a 
security policy which can be automatically inherited by all users.  

 

To configure ECL settings 

1. From the Notes client, select File > Security > User Security. 

In the Lotus Notes dialog, type the appropriate password and click Log In. 

The User Security dialog opens. 
2. In the left pane, select What Others Do > Using Workstation. 

3. In the When code is signed by list, select the desired server to sign the 
EAS Notes databases.  

4. Select the check boxes to Allow Access to: 

 File System 

 External code 

 Current Notes database (R8) / Current database (R7) 

 Environment variables 

 Network 

 External Programs 
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5. Select the check boxes to Allow ability to: 

 Send Mail 

 Read other notes databases (only necessary if you are acting as 
delegate) 

 Modify other Notes databases 

 Export data 
6. Click OK. 

The User Security dialog closes and the ECL settings are configured. 

NOTE  The templates should be signed with a trusted signature. 
 

Network Load Balancing Multi-Address Support 
EAS OWA 2007/2010 reads the configuration file to get multiple addresses of 
Network Load Balancing (NLB). This setting is used when users are 
accessing OWA through a  load balancer, or they cannot reach the individual 
nodes. [176409] 

Each address must end with semi-colon (";"), even the last address in the list. 
The OWA value must match the URL used to access OWA. White space is 
not allowed.  

Example: NLBInfo=webmail.company.local:443;owa2007.cus.fr:443; 
 

Meridio Categorization 
Meridio categorizations are now available in the EAS Client. Anonymous 
Access for EAS_Web must be turned off, and you must use "Windows 
Authentication". [174824] 
 

Show Progress Bar for Outlook Addin Stub Retrieval 
With this release of EAS, you have the option to show the progress bar for 
stub retrieval when using the Outlook Addin. By default, the progress bar is 
hidden to present a seamless action to the end user. [175873] 

If you want to display the progress bar for stub retrieval when using the 
Outlook Addin, add the following String Value to the registry: 

Location 

(depending on 32- or 64-
bit) 

HKEY_LOCAL_MACHINE\SOFTWARE\W
ow6432Node\EDUCOM TS\EASEXT 
or  
HKEY_LOCAL_MACHINE\SOFTWARE\E
DUCOM TS\EASEXT 

String Value Name SHOWPROGRESSONSTUB 
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Value data 1 

 
 

Custom Delimiter for Attachment Names in IDX File 
With this release, you can specify the delimiter used to separate attachment 
file names in the IDX file. By default the delimiter is a semicolon (;). [174353] 

To change the delimiter used to separate attachment names in the IDX file, 
add the following line under the [FULLTEXT] section of the eas.ini file, 
replacing customDelimiter with the desired delimiter character: 

AttachmentNamesDelimiter=customDelimiter 
 

New in EAS 6.3.1.2 
There are no enhancements included in EAS 6.3.1.2. 
 

New in EAS 6.3.1 
The following enhancements are included in EAS 6.3.1. 
 

Configure Indexer to Skip File Types 
For EAS For Files, the ExcludeAttachments parameter now supports 
excluding specific file types from being indexed.  

To allow the IDOL indexer to skip specific file types, add the 
ExcludeAttachments parameter and assign file types. 

Example: ExcludeAttachments=xls;mp3;mpeg;exe;dll; 

To configure Indexer to skip specific file types 
1. Open EAS.ini. 

2. In the [FULLTEXT] section, locate the ExcludeAttachments parameter. 

3. Add the desired file types you want the indexer to bypass. Separate file 
types with a semicolon. 

Save the file. 
4. Restart the EAS Indexer process. 

The specified file types are skipped during indexing going forward. 
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Change the Message Processing Order 
By default, EAS processes the newest messages first (last in, first out). You 
have the option of changing the order in which messages are processed by 
EAS. A parameter can be added to the EAS.ini file on the EAS Server to force 
processing to start with the oldest messages first (first in, first out). 

To change the order in which EAS processes messages to start with the 
oldest first 

1. On the EAS Server, open the EAS.ini file with a text editor (such as 
Notepad). 

2. Search for the [EAS_SERVER_OPTIONS] section. 

Add the following parameter and value to the [EAS_SERVER_OPTIONS] 
section: 

ArchiveMostRecentEmailsFirst=0 

TIP  To change the order back to processing the newest messages first, change 
the value for this parameter to 1. 

3. Save the file. 

The message processing order is changed to process messages staring 
with the oldest messages first. 

 

Alternate Configuration for Extended NT Account Synch 
In some Exchange environments, active directory mailbox permissions cannot 
be retrieved using Domain\Account format. This retrieval is related to having 
the "Extended NT Account Search" option enabled in EAS. 

An alternate configuration has been added to instruct EAS to retrieve mailbox 
permissions using the User Principal Name (UPN) format instead of the 
Domain\Account format. This configuration has been added to the 
INSTALLCONFIG table in the EAS database. 

To configure EAS for Exchange to use the UPN to retrieve mailbox 
permissions 

1. In the INSTALLCONFIG table of the EAS database, locate Key 1082. 

Change the value to 1. 

Key 1082 possible values: 0=perform NT account Synch only when the 
user information has been updated; 1=always perform NT Account Synch 
regardless of changes to the user information. 

2. Add the following Key as defined. 

Key: 1085 

Value: 1 
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Key 1085 possible values: 0: use Domain\Account format for Extended NT 
Account Synch; 1: use UserPrincipalName format for Extended NT 
Account Synch 

3. Restart the EAS Server service. 

4. Run a Synch DL task in the EAS Server. 

5. Confirm NTACCOUNT table is correctly populated. 
 

New in EAS 6.3.1.1 
There are no enhancements included in EAS 6.3.1.1. 

 

Resolved Issues 

EAS 6.4.1 Resolved Issues 
The following issues have been resolved in EAS 6.4.1. 
 

General EAS 
The following resolved issues apply to EAS in general. 

 With the new version of KeyView, PDFs created by third-party products 
are indexed into IDOL as expected. [174306] 

 An Auto Enroll task correctly enrolls users as expected. [178069]  
 Improved the memory usage during message retrievals. [179316] 
 Folder Sync tasks that include a large number of InterestedParty items 

complete processing as expected. [179384] 
 Messages index as expected when ExtractZips is enabled. [179440] 
 After the EAS Service is restarted, the selection for the "Restore Unicode 

PSTs" setting is retained as expected. [179029] 
 

EAS for Exchange 
The following resolved issues apply to EAS for Exchange. 

 When the EAS Recycle Bin option is not enabled, data is no longer moved 
to the recycle bin for uses with an OOASTATUS of NULL during a Folder 
Sync task with the option to Process All Exchange Users selected. 
[179341] 
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 When archiving multiple journal mailboxes, EAS processes complete as 
expected. [179394] 

 Exchange 2003 Information Store will no longer crash under certain 
Journal Archive scenarios. [179411]  

 Using the Outlook Add-in, searches for a folder whose name contain an 
ampersand (&) return results as expected. [179345] 

 Offline Sync now functions as expected when an Exchange Org Name 
contains an ampersand (&). [179431]  

 When "Store Full Recipients List" is selected, a "dead engine" error is no 
longer returned when an empty address (such as, 
johndoe@company.com; ; janedoe@company.com) is encountered in the 
To field of an email message during the archive process. [179376] 

 When using the Outlook 2010 Add-in in non-English environments, the 
recipients in the address list for the To and From fields are now ordered in 
the same manner as in Outlook's default address book. [179399] 

 Mailboxes for disabled users can now be viewed in the Web client, 
consistent with the Outlook Add-in. [179429] 

 

EAS 6.4.0.4 Resolved Issues 
The following issues have been resolved in EAS 6.4.0.4. 
 

General EAS 
The following resolved issues apply to EAS in general. 

 Indexer cleans up the render directory as expected. [169434] 
 Double-byte folder names display as expected in the EAS Web Client. 

[179193] 
 IDOL searches for folder names return expected results. [179212] 
 EAS IIS retrieves data as expected from EMC Centera devices. [179251] 
 

 Stopping/starting the EAS Indexer Service does not adversely affect the 
Event Viewer. [179624] 

 Searches containing "ALL" from the web client in Anonymous mode return 
results as expected. [179281] 

 

 The order of the list of file extensions for archiving does not adversely 
affect archiving. [179257] 

 Journaled messages containing only Bcc recipients are archived as 
expected. [179317] 

 Unicode user names display as expected in EAS Search. [179674] 
 The Auto Enroll task performs as expected. [178616] 
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EAS for Exchange 
The following resolved issues apply to EAS for Exchange. 

 Messages containing attachments with Unicode characters in the file 
name open as expected in Outlook. [170538] 

 Users granted EAS View permissions can "Restore Mail to PST" in an 
Exchange 2010 environment as expected. [173531] 

 Enable PST Gathering functions as expected using the EAS Outlook Add-
in. [177002] 

 When a distribution list is granted access to a mailbox in Active Directory, 
IDOL search results include the mailbox to which access was granted. 
[179274] 

 

 When a stub is restored using the EAS Outlook Add-in, the message 
retains the same list of properties as if restored using the Client. [179340] 

 When a message is restored using the EAS Outlook Add-in, a single copy 
of the message is restored. [179364] 

 Exchange Managed Folders are discovered during a DL Synch as 
expected. [179155] 

 Using the EAS Outlook Add-in searches using multiple mailboxes return 
results as expected. [179273] 

 Quota archiving functions as expected, even when the mailbox has 
exceeded the Exchange storage limit. [1479296] 

 Subsequent runs of the EAS PST stub migrator task process as expected. 
[179323] 

 

 Archived items can be moved or copied in Outlook as expected. [178258] 
 Draft messages restored using the EAS Outlook Add-in no longer include 

a Sent date. [179200] 
 The Open button is shown or hidden in the EAS Outlook Add-in as set by 

the HideOpen registry key. [179221] 
 

 When running an Offline Sync using the Outlook 2010 Add-in, temporary 
files are removed if a download fails. [179230] 

 
 

 When running an automated PST Gathering using the EAS Outlook 2010 
Add-in, multiple PSTs can be gathered in the same session and the folder 
structure within the PSTs is retained as expected. [179260, 179255] 
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 All mailboxes associated with a user profile display in the Search criteria 
Folder list when using the EAS Outlook Add-in. Archive files (PSTs) 
associated with the profile now also display in the Folder list. [179263] 

 The value for the Total Stub Size displays as expected in the User Stat 
Report when the total stub size is greater than 2 GB. [179295] 

 Stub restoration and retrieval using the EAS Outlook 2010 Add-in 
functions as expected, and in a similar fashion to using Outlook. [179313, 
179354, 179040] 

 Improved performance for Offline Sync for EAS Outlook Client and EAS 
Outlook Add-in. [179320, 179322] 

 Exchange 2010 Dumpster Archiving scans the appropriate messages as 
expected. [179284] 

 The Help button displays as appropriate in the EAS Outlook Add-in. 
[179254] 

 

EAS for Notes 
The following resolved issues apply to EAS for Notes. 

 Certain Notes messages with minor corruption are now indexed as 
expected. [177538] 

 

EAS Discovery 
The following resolved issues apply to EAS Discovery. 

 Creating a case in a non-Unicode Oracle environment no longer 
generates a character mismatch error. [176145] 

 EAS Discovery client displays search results for public folders as 
expected. [178548] 

 Scheduled searches run as expected in 64-bit EAS environments with 32-
bit IIS. [179308] 

 When using Oracle 11g R2, cases can be created as expected. [177634] 
 Global searches in EAS Discovery perform as expected. [170095]  
 
 

EAS 6.4.0.2 Resolved Issues 
The following issues have been resolved in EAS 6.4.0.2. 
 

General EAS 
The following resolved issues apply to EAS in general. 
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 If the Indexer shuts down, it automatically restarts and releases the 
memory as expected. [175036] 

 During indexing, the Render directory is cleared as expected. [178619] 
 Stubs for signed messages marked for archive (clicked the Archive button 

in Outlook) are no longer blank, nor are the restored versions of those 
stubs. [178713] 

 

EAS for Exchange 
The following resolved issues apply to EAS for Exchange. 

 Deleting a message in the EAS Web Client removes the reference to the 
message in the FT_Notify table as expected. The message is not found 
when creating a search. [176242] 

 

 Messages stubbed with older versions of EAS can be opened with the 
Outlook 2010 EAS for Exchange Add-In and EAS Outlook Web Access 
2007 as expected. [176981, 176984] 

 

 Using EAS for Exchange with Exchange 2010, the "All Address List" in the 
Recipient Administrator populates as expected. [172740] 

 

 Cannot input Czech language characters in a regular email when the EAS 
Addin is installed. [177437]  

 

 When restoring a message from search using the EAS for exchange 
Addin, you are prompted for a location to save the message as expected. 
[177439] 

 

 RESTOREMESSAGESTOFOLDER ("Restore messages to folder" option 
in the installation) functions as expected using the EAS for Exchange 
Addin. [177479] 

 

 Word documents, and any documents with the ipm.document message 
class, can be retrieved as expected using the EAS for Exchange Addin. 
[177516] 

 

 Quota archiving no longer fails with an unhandled exception on 64-bit EAS 
server archiving from Exchange 2007. [178627] 

 

 Spell check no longer scans the full "forwarded" or "replied to" message 
when using the EAS for Exchange Addin. [178456] 

 

 Messages that have been forwarded or replied to are marked as "Read" 
as expected when using the EAS for Exchange Addin. [178791] 

 

 Error messages displayed as a result of the machine display (Control 
Panel > Display) being set higher than 100% no longer cause errors in the 
EAS for Exchange Addin. [178639]  
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 Searches can be performed as expected when GMT is used (in both EAS 
and Outlook). [178760] 

 Clicking an Internet "mailto" URL no longer opens two new messages 
when the EAS for Exchange Addin is installed. [178808] 

 

EAS Discovery 
The following resolved issues apply to EAS Discovery. 

 Cases can be created in EAS Discovery with Oracle 11g Release 2 as 
expected. [177634] 

 Cases in EAS Discovery can be closed as expected. Legal holds are 
removed as appropriate. [178680]  

 

EAS 6.4 Resolved Issues 
The following issues have been resolved in EAS 6.4. 
 

General EAS 
The following resolved issues apply to EAS in general. 

 Archiving a message and selecting a category functions as expected. 
[174942]. 

 In certain instances, the "purge non-referred rule" (Storage Management) 
ran indefinitely. [174844] 

 

 In certain instances, corrupted ZIP files remained in the temp directory. 
[176654, 176571] 

 

 Verifying/repairing HSM Archive no longer reports errors if HSM archives 
do not have PROFILE.STARTINGPOS set to 0. [176241] 

 

 EAS Client now supports Windows 7, 64 bit. [168846] 
 

 Active Directory permissions are applied as expected when Anonymous 
authentication is enabled on the EAS IIS server. [173986] 

 

 In certain instances, messages with large attachments were not indexed 
properly. [173529] 

 

 The French version of "Results per page" and "Pages" were not displaying 
correctly on the Search window of the EAS Client. Must be sure to set the 
LANGID registry key to the appropriate value (French=10360). [174174] 

 

 All database calls are now Oracle Compliant from the EAS Connector. 
[SE-2613] 

 

 In certain instances, the EAS Connector was not un-compressing files as 
expected, resulting in timeout errors. [176104] 
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 In certain instances, Copying (Storage Management) data to Digital Safe 
resulted in errors. [176087] 

 

 Messages that include a disabled EAS user as a recipient or sender can 
be opened by remaining message participants as expected. [169244]  

 Files containing invalid characters can be removed from temp directories. 
[177501] 

 

EAS for Exchange 
The following resolved issues apply to EAS for Exchange. 

 EAS stubs could not be retrieved using the EAS Outlook Addin when the 
Exchange Organization name contains an ampersand (&). [175004] 

 Search Results from the Outlook Addin could not be sorted. [175278] 
 

 EAS OWA button text was not displaying correctly in French. [170600] 
 

 Folder search button (elipsis) in the EAS Addin search populates more 
quickly. [176089] 

 

 When trying to retrieve a SMIME encrypted or signed email in Outlook 
2010 with the EAS add-in, the object opens as expected. [175696, 
176665] 

 

 In EAS OWA, opening an empty mailbox no longer generates an error 
reporting "script error updating toolbar". [176820] 

 

 The EAS OWA toolbar displays as expected in supported browsers. 
[174570] 

 

 Using EAS OWA 2010, opened messages are opened in a new window as 
expected in FireFox. Note: EAS OWA 2007 does not support FireFox. 
[176884] 

 

 The Client Permission Task now works with the EAS Outlook 2010 Add-in 
as expected. [173994] 

 

 When Outlook is connected to Exchange, the EAS Add-in checks the local 
offline cache first (if available) as expected. [175106] 

 

 Large Exchange messages are indexed as expected. [176255] 
 

 Attachments in Exchange 2010 messages are archived as expected. 
[177193] 

 

 With the EAS Addin installed, you can hide public folders from the 
"browse" folder functionality to keep the browse from hanging. The 
Registry Key Value "DisablePublicFolders" includes the ability to not 
display the public folders in the browse folder functionality in the search 
interface. Set the Value to "1" to hide public folders in the browse tree. 
[175144] 

 

 Forwarding message stubs from the Outlook Addin functions as expected. 
For a single message, the full message content is included in the 
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forwarded message. For multiple messages, the full message content of 
each message is added as an attachment and forwarded in a single 
'container' message. [175447, 175603] 

 

 Forwarding a message stub from the Outlook Addin Advanced Search 
results list forwards the selected message as expected. [176814] 

 

 Forwarding a message from the Outlook Addin includes the full message 
content (not as attachment) as expected. [175930] 

 

 EAS Outlook Addin Offline Sync causing Outlook to hang. The sync task 
now displays a progress bar in the background and the Outlook interface 
remains responsive. [174902, 175872, 176576] 

 

 The following timeout-related registry keys were missing from the Outlook 
Addin: OFFLINEDELAY, OFFLINEINTVAL, CONNECTIONTIMEOUT, 
RECIEVETIMEOUT. [174673, 174674, 175406] 

 GMT registry key was missing from the Outlook Addin. This key forces the 
EAS Client to use GMT time when calculating EAS SyncID and is used to 
force the Client and EAS IIS to both use GMT time. [176084] 

 

EAS for Notes 
The following resolved issues apply to EAS for Notes. 

 In certain instances, the archive threads were hanging on archive child 
servers. [174201] 

 Large Notes files process and index as expected. [175037] 
 

 Notes files index as expected and the "From", "To", and "Subject" fields 
are populated as expected. [176191] 

 Forwarded meeting invitations are archived as expected. [177370] 
 

EAS for Files 
The following resolved issues apply to EAS for Files. 

 File names containing curly brackets "{" or "}" are searchable in the EAS 
Client as expected. [175103, 175841] 

 EAS IDX files for FAS contain the expected content. [177635] 
 

EAS 6.3.1.2 Resolved Issues 
The following issues have been resolved in EAS 6.3.1.2. 
 

EAS Server 
The following resolved issues apply to EAS Server. 
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 When multiple recipients are specified in any of the mail recipient fields, all 
recipients are stored as expected. [168834] 

 When multi-language archiving is disabled, task formulas function as 
expected. [170360] 

 Synchronize Distribution Lists initializes Exchange 2007 cmdlets as 
expected. [173160] 

 In certain previous EAS for Exchange upgrade scenarios, forwarding a 
stubbed message generated two messages (one HTML and one Rich 
Text). This has been resolved by adding a string value named 
OpenWithUnicodeConversion with a value of 1 under 
HKEY_LOCAL_MACHINE\SOFTWARE\EDUCOM TS\EASEXT on the EAS 
Server. [173919]  

 When a subject line contains a leading space, Folder Sync with Refer 
Insertion inserts references as expected. [174100] 

 If "extra logging" or Event Logging is enabled, you will now see a log entry 
in the eas.log or event log for each repaired MSGID. The log entry will 
contain a message similar to: "Archive Repair Operation Updated 
Startingpos from '-2147458384' to '2147508912' for MSGID 1944. " 
[174470] 

 HSM files larger than 2GB are read and processed as expected. [174762] 
 In certain scenarios, file archiving would hang when processing large files. 

This has been resolved. [174967] 
 NTFS Sparse File stubbing and retrieving function as expected. [175161] 
 Messages captured by Envelope Journaling are processed fully as 

expected. [175307] 
 

EAS 6.3.1.1 Resolved Issues 
The following issues have been resolved in EAS 6.3.1.1. 
 

EAS Archive 
The following resolved issues apply to EAS Archive. 

 Folder Sync with Refer Insertion inserts references as expected when a 
subject line contains a trailing space. [174361] 

 Folder Sync completes as expected when the value for 
INTERESTEDPARTY GetValuePtrNullException is NULL. [173683] 

 

 Day Archive files can now grow over their defined limit during a single 
processing, but cannot be added to once over this limit. [171644, 174375] 

 

 Oversize Day Archive files can be repaired as expected. [174467] 
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 EAS Views performs as expected when saving verify results. [174677, 
170233] 

 

 When "Ignore EAS Recycle Bin" is enabled, the Dumpster Archive 
processes as expected after a Folder Sync is performed. See Dumpster 
Archiving (see "Dumpster Archiving (6.3.1.1)" on page 31). [170707] 

 Archive tasks in a journal mailbox process as expected. [174889] 
 

EAS Outlook Web Access 
The following resolved issue applies to EAS Outlook Web Access (OWA). 

 For Exchange 2010 messages, EAS OWA search results that contain 
messages invoked by CopyTo return successfully. [173175] 

 

EAS 6.3.1 Resolved Issues 
The following issues have been resolved in EAS 6.3.1. 
 

General EAS 
The following resolved issues apply to EAS in general. 

 The Storm Service log can be viewed as expected. [170963] 
 EAS IDOL queries return expected results when searching against the 

default language. [172791] 
 

 Running Indexer with NoRTFBody option performs as expected. [172615, 
169107] 

 

 In certain instances, some messages in journaled mailboxes were not 
able to be processed. [171852, 171857, 172062, 173316, 173301, 
173823] 

 

 The maximum file size that can be indexed has been raised. [172134] 
 

 In certain scenarios, processing a single message by two users 
simultaneously generated errors. [172819] 

 Discovery installation for Windows 7, x64 successfully completes as 
expected. [174313] 

 

EAS Client 
The following resolved issues apply to the EAS Client. 

 Attachment icon remains visible when a stub is flagged. [167232] 
 Message retrieval functions as expected with EAS IIS anonymous access 

disabled. [172766] 
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 When a stubbed message is attached to an email message, the message 
recipient can view the original content of the stubbed message. [173400] 

 

 A stubbed message that has a "sent timestamp" and "received timestamp" 
that differ by milliseconds is stored as a single message item. [173786] 

 Stubs copied/moved from one folder to another retain original timestamps 
as expected. [174349] 

 

EAS for Exchange 
The following resolved issues apply to EAS for Exchange. 

 EAS Outlook Web Access (OWA) functions as expected for Exchange 
2010, Windows 2008 R2. [171758, 171023, 175175] 

 When using a Network Load Balancing Cluster, you can download 
message attachments in EAS OWA as expected. [172340] 

 

 EAS OWA uninstalls as expected. [172028] 
 

 The Outlook Client Add-in installs as expected and the Archive-related 
buttons function as expected. [172579, 172969, 173235, 173912] 

 

 Use the Synch button in the Outlook Client Add-in to synchronize to the 
local cache. Then, when in Outlook Offline Mode (Use Cached Exchange 
Mode enabled), a message that has been stubbed can be opened and the 
original content viewed. [173418] 

 

 If a network connection is lost, opening a stubbed message in the Outlook 
client pulls from the local cache as expected. [173422] 

 

 Password protected PST files are archived as expected. [171321] 
 

 When archiving based on mailbox quota, mailboxes are reduced by 
percentage limit as expected. [172581] 

 

 When "Extended NT Account Synch" is enabled in the EAS Administrator, 
messages are archived as expected. [172754] 

 Searches within the mail client containing specific special characters—% - 
[ ] { } ~—return expected results. [173955] 

 

EAS for Lotus Notes 
The following resolved issues apply to EAS for Lotus Notes. 

 Messages that are indexed and then flagged are re-indexed as expected. 
[169972] 

 Large message attachments can be viewed as expected. [172228] 
 

EAS for Files 
The following resolved issues apply to EAS for Files. 
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 End user client messages for searches that have no matches have been 
updated. [171039] 

 Search results are returned as expected. [173536, 173797] 
 

Notes 

EAS 6.4.1 Package 
This release includes the following: 

 Discovery_6.4.1.0.zip 
 DiscoveryWebService_6.4.1.0.zip 
 EASClient_6.4.1.zip 
 EASClient_6.4.1.0_x64.zip 
 EASDBMonitor_6.4.1.0.zip 
 EASIdol_6.4.1.0.zip 
 EASIdol_x64_6.4.1.0.zip 
 EASIIS_6.4.1.0.zip 
 EAS Indexer_6.4.1.0.zip 
 EASServer_6.4.1.0.zip 
 NotesTemplates_6.4.1.0.zip 
 EASOutlookAddin_6.4.1.0.zip 
 EASOutlookAddin_6.4.1.0_x64.zip 
 EASOutlookAddin_6.4.1.0_x64o32.zip 
 EASFilter_6.4.1.0_x64.zip 
 EASFilter_6.4.1.0.zip 
For this release, the EAS database is not updated. Additionally, Domino Web 
Access (DWA) is not included in this release. 

The components in the installation package are contained in ZIP files. Once 
extracted from the ZIP, run the setup.exe file as Administrator to perform the 
component installation. The exception to this is the ZIP for the Lotus Notes 
templates—extract and install as per instructions. 

Note: There are two versions of several components: one for 32-bit 
applications (component_release.zip) and one for 64-bit applications 
(component_release_x64.zip). Be sure to download and install the version 
appropriate for your Operating System. 
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Install and Run with Admin Rights on Windows Server 
2012 
When installing EAS in a Windows Server 2012 environment, install each 
EAS package (EXE file) as an Administrator (right-click > Run as 
Administrator). You may also want to disable UAC during the installation 
process. 

Additionally, the following EAS components must be run with administrator 
rights. 

 EAS Indexer 
 EAS Server 
 EAS Storage Manager 
 EAS Storage Manager Agent 
 EAS Storage Manager Server 
 EAS Views 

To run an EAS component with administrator rights 
1. Log on to the machine hosting the desired EAS component as an 

administrator. 

2. Open the Start menu and locate the desired EAS component. 

3. Right-click the component and select Run as administrator. 
 

User Account Control on Windows Server 2008 R2 
If installing in a Windows Server 2008 R2 environment, the administrator 
account used to complete the installation of the EASServer must have the 
User Account Control (UAC) turned off—failure to do so may result in an 
incomplete installation and improper operation. The UAC must remain off for 
this account.  
 

This procedure must be completed prior to installing the EASServer. 

Note: UAC is not present in server environments earlier than Windows 2008. 

 

To turn off UAC 

1. Log on to the server that will host EASServer with the administrator 
account that will be used to install the EASServer. 

2. Open the Control Panel. 

3. Open User Accounts. 
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The User Accounts tasks window opens. 
4. Open (double-click) Turn User Account Control on or off. 

If UAC is currently configured in Admin Approval Mode, the User Account 
Control message appears. Click Continue. 

The Turn User Account Control On or Off window opens. 
5. Clear the Use User Account Control (UAC) to help protect your 

computer check box. 

Click OK. 

A confirmation dialog displays stating that the computer must be restarted 
for the changes to be applied. 

6. Click Restart Now to apply the change right away. Close the User 
Accounts tasks window. 

For more information regarding User Account Control, refer to the Microsoft 
Technet library. 
 

Create Exchange 2010 Remote Runspace Connection 
Applies to 6.4.1 forward 

Due to changes in the previous local runspace, the ExchComlet is now 
recreated during the installation of the EAS Server for EAS for Exchange 
2010 to use remote runspace. 

New Installations 

For new installations, EAS Server will need to obtain the Exchange 2010 
server name to initialize the remote runspace connection. During installation, 
you will be prompted to define the Exchange server name. The value is then 
stored as a string value for a new registry key. 

 for 32-bit environments: 
Key: HKLM\SOFTWARE\ZANTAZ\ExchComlet 

Value Name: ExchangeServer 

Value type: REG_SZ 

Value data: Exchange 2010 server name 

 for 64-bit environments: 
Key: HKLM\SOFTWARE\Wow6432Node\ZANTAZ\ExchComlet 

Value Name: ExchangeServer 

Value type: REG_SZ 

Value data: Exchange 2010 server name 
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Upgrades 

For upgrades it is recommended that you uninstall the existing version of EAS 
Server and then reinstall it using the current installer to finish the upgrade. 

Alternately, you can manually create the registry key with details defined for 
new installations. Since using remote runspace does not require copying all 
Exchange management tool binaries, you can manually delete those binaries 
although there is no harm in keeping them. 
 

EAS Discovery Web Service URL 
The EAS Discovery Web Service URL is incorrectly referenced in the EAS 
Discovery Administration Guide. The correct EAS Discovery Web Service 
URL is: 

http://webserver_name/EASDiscovery/EASDiscoveryWebService
.asmx 
 

Unicode Database 
To install a Unicode db for initial installs, run the Unicode DB create script 
(mssql_create_unicode.sql or oracle_create_unicode.sql). 

If you are using a database using NVARCHAR fields, ensure that the following 
setting is added to eas.ini under the [EAS_SERVER_DB] section: 
DatabaseUseU16Insert=1.  
 

Multi-Language Archive 
Applies to EAS for Exchange 6.4.0.2, going forward 

When upgrading to this release, update your configuration settings to enable 
"Multi-language Archive" prior to ingesting new mail. Failure to do so may 
result in partial data loss. Use of this setting ensures that items containing 
characters from multiple languages are archived as expected and 
discoverable in searches. 

Contact Technical Support about enabling Multi-language Archive and the 
impact of doing so. 
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Exchange Management Tools 
Applies to all versions of EAS for Exchange. 

 EAS for Exchange requires that the files that comprise Exchange 
Management Tools also exist in the EAS program files directory. The version 
of Exchange Management Tools (Exchange 2007 and Exchange 2010) on the 
EAS server should match the version installed on the Exchange servers. 

Failure to maintain consistent versions may result in operations such as 
Extended NT Account Sync, Quota Archive, and Auto-enroll not functioning 
properly in conjunction with Exchange 2007 or Exchange 2010.  
 

The following procedure should be completed if you 

 install or upgrade EAS, or 
 upgrade Exchange Management Tools on an EAS Server. 
 

To update the EAS program files directory with the current Exchange 
Management Tools files 

1. Ensure that Windows Explorer is showing hidden files and Protected 
System files. 

2. Select and copy all files and subfolders in the Exchange Management 
Tools BIN folder (C:\Program Files\Microsoft\Exchange Server\V14\Bin). 

3. Paste copied files and subfolders into the EAS program folder 
(C:\Program Files (x86)\ZANTAZ\EAS), replacing all files when prompted. 

 

Notes Split Attachment Feature 
Applies to 6.4 and 6.4.0.2 

The split attachment feature for Notes is not supported. If using this feature, 
do not upgrade to this release. 
 

KeyView Processing Time for Attachments (6.3.1.2) 
The default amount of time that KeyView will continue to process an 
attachment is 60 seconds. If your environment typically processes very large 
attachments, you may want to increase the KeyView attachment processing 
time. [175329] 

Caution! Increasing the time KeyView spends processing an attachment 
before timing out can affect performance. It is recommended that any 
increases to this value are made in small increments and tested. 
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To configure the amount of time KeyView spends processing an 
attachment 

1. On the machine hosting the EAS Indexer, open eas.ini with a text 
editing program (such as Notepad). 

2. Add the following configuration to the [FULLTEXT] section. 

ConverterTimeout=60 
3. Save eas.ini. 

4. Restart the EAS Indexer host for the configuration to take effect. 

5. Test processing of large attachments for timeout and performance. 

6. Repeat as necessary to adjust the ConverterTimeout for your 
environment. 

 

OWA for Exchange 2010 Icon Display (6.3.1.1) 
After installing EAS OWA (Outlook Web Access), the buttons and icons may 
not display properly in OWA for Exchange 2010. 

To properly display the buttons and icons in OWA for Exchange 2010, disable 
the Exchange OWA Gzip Compression on the CAS server.  
 

To disable the Exchange OWA Gzip Compression on the CAS server 

1. Log on to the CAS server with an account that has write access to virtual 
directory objects in Active Directory. 

2. Open Exchange Management Shell and run the following cmdlet. 

Set-OwaVirtualDirectory -Identity "owa (Default Web 
Site)" -GzipLevel Off 

3. Restart IIS using the command iisreset/noforce. 

Gzip Compression is disabled and IIS is restarted so that the change 
takes effect. 

For more information about Set-OwaVirtualDirectory, see the Microsoft 
TechNet article http://technet.microsoft.com/en-us/library/aa996547.aspx 
http://technet.microsoft.com/en-us/library/aa996547.aspx. 
 

Dumpster Archiving (6.3.1.1) 
To enable Dumpster Archiving, you must enable the "Use EAS Recycle Bin" 
option on the General tab of EAS options. Any existing Dumpster Archive 
tasks must be recreated. [170707] 
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EAS Outlook Addin Installation 
The EAS Outlook Addin installation has the following considerations. 

 As of EAS 6.4.0.4, Office 2010 Primary Interop Assemblies are a 
prerequisite for all Outlook 2010 users using the EAS Outlook Addin. By 
default, this prerequisite is included in the Office 2010 installation. In some 
scenarios, the Primary Interop Assemblies are not installed with Office 
2010. If this occurs, an error, similar to the following, displays when 
running the offline sync.  

"Folder Scan Error: System.IO.FileNotFoundException: 
Could not load file or assembly 'ADODB, 
Version=7.0.3300.0, Culture=neutral, 
PublicKeyToken=b03f5f7f11d50a3a' or one of its 
dependencies. The system cannot find the file 
specified. File name: 'ADODB, Version=7.0.3300.0, 
Culture=neutral, PublicKeyToken=b03f5f7f11d50a3a. Check 
whether .NET Programmability Support or Microsoft 
Office 2010: Primary Interop Assemblies are installed 
with Outlook" 

If you receive this error, Primary Interop Assemblies are not installed. To 
resolve this error, complete one of the following: 

 Download and install Primary Interop Assemblies from Microsoft, 
http://www.microsoft.com/en-us/download/details.aspx?id=3508 
http://www.microsoft.com/en-us/download/details.aspx?id=3508. 

 Manually modify the Outlook/Office installation to install .NET 
Programmability Support. 

Open Control Panel > Programs and Features. Select Microsoft 
Office 2010 and click Change. In the resulting dialog window, select 
Add or Remove Features and click Continue. Expand the installation 
options and navigate to Microsoft Office > Microsoft Outlook > .NET 
Programmability Support. Click the down arrow button to the left of 
.NET Programmability Support and select Run from My Computer. 
Click Continue and complete the installation. 

 As of 6.3.1, you may see an error message when installing the EAS 
Outlook Addin for Outlook 2007 in some scenarios. The message states 
that the Addin failed to register. 

To resolve this, open a command prompt and execute the following 
statement on the machine for which you received the message: 

rundll32 dfshim CleanOnlineAppCache 
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Online Day Archive Updates 
Significant updates have been made to the Online Day Archive in this release 
of the product. If you are currently using Online Day Archive in EAS 6.3.0, 
Autonomy recommends upgrading to EAS 6.3.1 to take advantage of these 
important updates.  
 

Content Searches 
Content searches in EAS Discovery, EAS Client and EAS Add-in search the 
email body and the attachment body. 
 

IDOL 
A newer version of IDOL (7.4) was integrated into EAS IDOL versions 6.1.4 
and higher. If you are using EAS IDOL 6.1.4 or older, a re-index of all content 
is suggested but not required. A re-index allows you to apply more powerful 
features to indexing and searching your content, but should not dramatically 
change search results.  
 

If you are already running EASIdol_6.1.4.x or higher, re-indexing is not 
required. 

Note: This applies to the version of EAS IDOL. Re-indexing may be required 
for other reasons. 
 

Important Upgrade Information 

Important!  Due to updated components in this release, the upgrade process 
for this release requires recreating all EAS Storage Manager Tasks in specific 
scenarios.  

• If upgrading to EAS 6.3.1 from EAS 6.2.1.5 or earlier, the following 
procedure must be performed for a successful upgrade. 

• If upgrading to EAS 6.3.1 from 6.3, the following procedure does NOT 
need to be performed. 

 

Prior to upgrading to this release of EAS, it is recommended that you 
document the details of all existing EAS Storage Manager Tasks. During the 
upgrade itself, all existing Tasks are removed. After the upgrade is 
completed, you must recreate all of your EAS Storage Manager Tasks.  
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If you need assistance in reviewing and recreating your tasks, contact 
Technical Support. 
 

For more information regarding Tasks in EAS, refer to the EAS Storage 
Manager Administration Guide, "Managing Content" > "Creating and running 
Storage Manager tasks". 
 

To complete the upgrade successfully 

1. Document the details of all existing EAS Storage Manager Tasks. 

2. Disable all existing EAS Storage Manager Tasks. 

Important!  Disabling tasks lets you make any necessary changes before the 
Tasks are automatically executed after the upgrade. 

3. Delete any Pending EAS Storage Manager Tasks. 

4. Complete the upgrade. 

5. Verify all EAS Storage Manager Tasks and edit or recreate them as 
necessary. 

6. Enable all EAS Storage Manager Tasks. 

To document the details of your current Tasks 

1. Open the Storage Manager client and navigate to the Tasks node.  

2. For each task that you would like to recreate, make note, or take a 
screenshot, of the following information: 

 Task Name and Options on the Task Properties tab, and any additional 
tabs present for the particular task. 

 For COPY tasks: Action, Retention Period options, and additional 
options on the Task Properties tab; Rules, their placement on the grid, 
and how those rules are combined (for example, AND, AND NOT); The 
Destination Document Stores tab, which document stores are listed in 
the Destination Document Stores column. 

 For COPY TO NSF FILE tasks: Action and Destination File on the Task 
Properties tab; Rules, their placement on the grid, and how those rules 
are combined (for example, AND, AND NOT). 

 For COPY TO PST FILE tasks:  Action, Retention Period options, and 
additional options on the Task Properties tab; Rules, their placement 
on the grid, and how those rules are combined (for example, AND, 
AND NOT). 

 For MOVE tasks: Action, Retention Period options, and additional 
options on the Task Properties tab; Rules, their placement on the grid, 
and how those rules are combined (for example, AND, AND NOT); The 
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Destination Document Stores tab, which document stores are listed in 
the Destination Document Stores column. 

 For EXTEND RETENTION tasks: Action, Retention Period options, 
and additional options on the Task Properties tab; Rules, their 
placement on the grid, and how those rules are combined (for 
example, AND, AND NOT). 

 For QUOTA tasks: Action, and User rule option on the Task Properties 
tab; Rules, their placement on the grid, and how those rules are 
combined (for example, AND, AND NOT); Options and message 
templates on the Quota Properties tab. 

 For DELETE REFERENCES tasks: Action on the Task Properties tab; 
Rules, their placement on the grid, and how those rules are combined 
(for example, AND, AND NOT). 

 For DELETE tasks: Action on the Task Properties tab; Rules, their 
placement on the grid, and how those rules are combined (i.e. AND, 
AND NOT). 

 For PURGE tasks: Action on the Task Properties tab; Rules, their 
placement on the grid, and how those rules are combined (for 
example, AND, AND NOT). 

 For PURGE & WIPE tasks: Action on the Task Properties tab; Rules, 
their placement on the grid, and how those rules are combined (for 
example, AND, AND NOT). 

To document the details of your current Scheduled Tasks 

1. Open the Storage Manager client, and navigate to the Scheduled Tasks 
node.  

2. For each scheduled task, make note, or take a screenshot, of the 
Scheduled Action.  

These actions will be removed during the upgrade.  
 

Configure Character Encoding for FAS Search 
The default character encoding used by FAS Search is Windows-1252, which 
is for Western Languages (Latin alphabet; English and some European 
languages). FAS Search uses EAS IIS and the change that must be made is 
made to the configuration for EAS IIS. 
 

The encoding of the original file system must be known in order to display 
folder names properly using FAS Search. This is important when a non-
UNICODE database schema is used, and the default Operating System 
installation (or user expectation) uses anything other than the default 
encoding of Windows-1252.  
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If the UNICODE database schema is used, this procedure is not required 
regardless of what the end user sees. 

IMPORTANT This change is global for the EAS IIS component. Therefore, 
you cannot mix character sets if you are using an old database (non-
UNICODE) schema. 

 

To configure the character encoding for FAS Search 

1. Log on to the machine hosting EAS IIS. 

2. With a text editing tool (such as Notepad), open eas.ini. 

NOTE The eas.ini file is located in the Windows directory, typically 
C:\Windows. 

3. In the [Web] section add the following parameter, replacing <charset> 
with the character encoding appropriate for your environment: 

FolderNamesUseXMLEncoding=<charset> 
4. Save and close the file. 

EAS IIS is configured for the character encoding appropriate for your 
environment. 

 

Examples 

 If the original system where a certain folder structure exists has Windows 
2003 installed and it was installed using the Simplified-Chinese installation 
(which defaults to CodePage 936), you would add the character encoding 
parameter as follows: 

FolderNamesUseXMLEncoding=GB2312 

 Similarly, if the original system was installed using the standard Japanese 
installation (which defaults to CodePage 932), you would add the 
character encoding parameter as follows: 

FolderNamesUseXMLEncoding=Shift-JIS 
 

EAS For Exchange Quota Archive Task 
Applies Exchange 2010 environments. 

If using the Quota Archive task in EAS to automatically enroll new mail system 
users as EAS users, Exchange 2010 Management Tools must be installed on 
all EAS servers. 

IMPORTANT  Exchange 2010 Management Tools can only be installed on 64 
bit operating systems. 
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Applies to Exchange 2007 and Exchange 2010 environments. 

Quota Archive tasks should not have the Loop Continuously option configured 
(Schedule Info tab, clear this check box). This is because the Exchange 
Information Store service uses the cached mailbox configuration to enforce 
mailbox size limits and any changes to that configuration change do not take 
effect until the cache is refreshed. For more information about how mailbox 
size limits are enforced in Exchange 2007 and 2010, refer to 
http://technet.microsoft.com/en-us/library/bb684892(EXCHG.80).aspx 
(http://technet.microsoft.com/en-us/library/bb684892(EXCHG.80).aspx). 
 

EAS for Exchange Auto Enroll Task 
Applies to Exchange 2010 environments. 

If using the Auto-Enroll task in EAS to automatically enroll new mail system 
users as EAS users, Exchange 2010 Management Tools must be installed on 
all EAS servers. 

IMPORTANT  Exchange 2010 Management Tools can only be installed on 64 
bit operating systems. 
 

Run EAS IDOL Indexer Before Conducting a Search 
You must run the EAS IDOL Indexer at least one time before conducting a 
search to update EAS IIS. Running the EAS IDOL Indexer adds necessary 
fields to the IDOL index. 
 

Configure IIS 6.x for EAS OWA 
In this release of EAS, a few manual configurations are required in IIS 6.x to 
support EAS Outlook Web Access (OWA). If using IIS 7.x, these manual 
configurations are not required. 
 

Complete the following procedures for IIS 6.x, in the order indicated, 
immediately following the installation of EAS OWA. 

1. Create the ISAPI filter for EAS OWA (see "Create the IIS 6.x ISAPI Filter for 
EAS OWA" on page 38). 

2. Create the application mapping for EAS OWA (see "Create the IIS 6.x 
Application Mapping for EAS OWA" on page 38). 
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Create the IIS 6.x ISAPI Filter for EAS OWA 
In this release, the ISAPI filter for EAS OWA needs to be manually created in 
IIS 6.x. 

To create the ISAPI filter for EAS OWA 

1. Log on to the server hosting EAS Outlook Web Access as an 
administrator. 

2. Open Administrative Tools > Internet Information Services (IIS) 
Manager. 

3. In the left pane, navigate to server > Web Sites > Default Web Site. 

Right-click Default Web Site and select Properties. 

The Default Web Site Properties dialog opens. 
4. Select the ISAPI Filters tab. 

Click Add. 

The Add/Edit Filter Properties dialog opens. 
5. In the Filter name field, type EASOWA. 

Click Browse to navigate to the filter Executable. 

Navigate to and select drive:\Program 
Files\ZANTAZ\EASOWA\OWA\Root\easowaf.dll. 

6. Click OK; the Add/Edit Filter Properties dialog closes. 

In the ISAPI Filters tab of the Default Web Site Properties dialog, the EAS 
OWA filter displays in the list of filters. 

Click OK; the Default Web Site Properties dialog closes and the ISAPI 
filter is created for EAS OWA. 

 

Create the IIS 6.x Application Mapping for EAS OWA 
In this release, the EAS OWA application mapping needs to be manually 
configured in IIS 6.x. 

To create the application mapping for EAS OWA 

1. Log on to the server hosting EAS Outlook Web Access as an 
administrator. 

2. Open Administrative Tools > Internet Information Services (IIS) 
Manager. 

3. In the left pane, navigate to server > Web Sites > Default Web Site > 
eas-web application. 

Right-click eas-web application and select Properties. 
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The eas-web application Properties dialog opens. 
4. Select the Virtual Directory tab. 

In the Application setting section, click Configuration. 

The Application Configuration dialog opens. 
5. In the Application extensions section, click Add. 

The Add/Edit Application Extension Mapping dialog opens. 
6. Complete the fields in the following manner. 

a) Click Browse to navigate to the Executable. 

Navigate to and select drive:\Program 
Files\ZANTAZ\EASOWA\OWA\Root\easowae.dll. 

b) In the Extension field, type srf. 

c) In the Verbs section, select Limit to. 

d) In the Limit to field, type GET,HEAD 

e) Select Script Engine and select Verify that the file exists. 

Click OK; the Add/Edit Application Extension Mapping dialog closes and 
the .srf extension displays in the Application extensions list. 

7. Click OK; the Application Configuration dialog closes. 

Click OK, the eas-web application Properties dialog closes. 

The application mapping for EAS OWA is created. 

 
 

Configure EAS.ini for Meridio Integration 
When EAS is integrated with Meridio, a parameter must be added to the 
EAS.ini file. This parameter specifies to display the 
MeridioRecordsManagement value for messages restored through the EAS 
Administrator. 

The EAS.ini file must be updated as specified on EAS Server and the IDOL 
Index server. 
 

To configure the EAS.ini file for Meridio Integration 

1. Open the EAS.ini file. 

2. Search for the [FULLTEXT] section. 

Add Meridio=1 to the [FULLTEXT] section. 
3. Search for the [EAS_SERVER_OPTIONS] section. 
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Add Meridio=1 to the [EAS_SERVER_OPTIONS] section. 

Save the file. 
4. Restart the EAS Indexer process. 

The EAS.ini file is configured for Meridio integration. 
 

General Installation Procedures 
Install EAS 6.4 as described in the EAS Installation Guide (EAS for Exchange, 
EAS for Lotus Notes, EAS for Files or EAS for SharePoint version). 

When installing EAS for Exchange, configure LDAP within the EAS 
Administrator prior to connecting to the Exchange Server. 

The components in the installation package are contained in ZIP files. Once 
extracted from the ZIP, run the setup.exe file as Administrator to perform the 
component installation. The exception to this is the ZIP for the Lotus Notes 
templates—extract and install as per instructions. 

Note: There are two versions of several components: one for 32-bit 
applications (component_release.zip) and one for 64-bit applications 
(component_release_x64.zip). Be sure to download and install the version 
appropriate for your Operating System. 
 

Licensing 
All products in the Autonomy EAS family require a valid license key and 
license agreement. Contact your Autonomy Channel Manager or Account 
Executive if you require licensing assistance, or call 1.800.636.0095 to speak 
with a customer service representative. 

 

Upgrade to EAS 6.4 

Autonomy Upgrade Assistance 
Autonomy can be contracted to perform a Health Check and System Upgrade 
procedure for your EAS environment.  

In addition to upgrading, Autonomy can provide knowledge transfer 
surrounding the new version functionality, configuration, and updates.  
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Upgrade services can be performed either on site or remotely over an Internet 
connection. If you are interested in such services, Autonomy can supply the 
Health Check and Upgrade Statement of Work (SOW). Please e-mail eas-
projects@zantaz.com for more information.    
 

Download the Software 
EAS software is available for download from the Autonomy Customer Support 
site (https://customers.autonomy.com/). 
 

Upgrade Script Directories 
The upgrade process requires a number of upgrade scripts to be run, 
although the exact number depends on the installed version of EAS. The 
necessary scripts should be contained in the <install>\scripts\ 
directory, where <install> is the EAS installation directory. However, in 
some cases additional upgrade scripts may be required; these scripts can be 
found in <install>\additional\ directory. 
 

Check EAS Database Updates 
Some EAS upgrades require an update of the EAS database schema. 

If you are not sure whether the updates have already been applied to your 
EAS database, you can check by reviewing the 
DATABASE_SCRIPT_HISTORY table. 

This table lists the database script date and name. For example, the SQL 
database query SELECT * FROM DATABASE_SCRIPT_HISTORY run in the 
tables directory of your EAS installation would yield a result similar to the one 
shown in the following illustration: 

 

This table was introduced in EAS Release 6.1.3.0 and captures details of 
database update scripts executed subsequent to the installation of EAS 6.1.3. 
 

Enable Multi-Language Archive 
Applies to EAS for Exchange 
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Prior to ingesting new mail, update your configuration settings to enable 
"Multi-language Archive". Failure to do so may result in archiving corrupt data. 

Contact Technical Support about enabling Multi-language Archive and the 
impact of doing so. 

IMPORTANT  Multi-language Archive must be enabled before ingesting new 
mail. 
 

Update LDAP Settings 
Applies to 6.4.1 forward 

Due to changes in Exchange, information about Mail Users must be accessed 
using LDAP. With this change, the following settings must be configured in the 
EAS Admin. 

 Settings > EAS Options > View > Exchange LDAP Settings 
 Settings > EAS Options > Parent Specific > Exchange LDAP Settings 
 

Upgrade to EAS 6.4.1 from EAS 6.1.2.x and Higher (Non-
Unicode) 
As of EAS release 6.2.0.0, both Unicode and non-Unicode upgrade scripts 
are available. For Unicode conversion scripts, see Upgrade Database for 
Unicode Support (on page 43). 

To upgrade to EAS 6.4.1 from EAS 6.1.2.x, run the required upgrade scripts 
as documented in the EAS Installation Guide (EAS for Exchange, EAS for 
Lotus Notes, EAS for Files or EAS for SharePoint version). 

IMPORTANT! Back up the EAS database prior to upgrading. 

Note: As of EAS release 6.1.5.0, the directory structure of the scripts was 
reorganized for improved usability. 

1. Download the EAS 6.4 release package from the Autonomy Customer 
Support site (https://customers.autonomy.com/). 

2. Run the installers for the EAS Server EAS 6.4. 
 

Upgrade to EAS 6.4.1 from EAS 6.0 or EAS 6.1 
To upgrade to EAS 6.4.1 from EAS 6.0 or EAS 6.1, you must first run the 
upgrade scripts for EAS 6.1.2. Ensure that your environment meets the 
minimum system requirements as stated in the EAS EAS 6.4 Installation 
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Guide (EAS for Exchange, EAS for Lotus Notes, EAS for Files or EAS for 
SharePoint version). 

IMPORTANT! Back up the EAS database prior to upgrading. 

1. Download the EAS 6.4 release package from the Autonomy Customer 
Support site (https://customers.autonomy.com/). 

2. Run the installers for the EAS Server EAS 6.4. 

3. Run one of the following upgrade scripts on the EAS database: 

 mssql_610_to_6120.sql for MSSQL databases 

 mssql_bigint_create.sql    

 oracle_610_to_6120.sql for Oracle databases   

Note: If you have previously installed updates that have been rolled into EAS 6.4 
you may see error messages indicating that tables added by the upgrade script 
already exist in the EAS database. These messages can be ignored. Only those 
tables not already in the database are added. 

4. Run the installers for the EAS products you are interested in. 

5. Upgrade to EAS 6.4.1 from EAS 6.1.2.x (see "Upgrade to EAS 6.4.1 from 
EAS 6.1.2.x and Higher (Non-Unicode)" on page 42) 

 

Upgrade Database for Unicode Support 
Database conversion is only required for specific language requirements.  

Conversion is not required if you are using a database with a true 8-bit 
character set. The default database character set on English versions of 
Oracle (WE8ISO8859P1) is not a true 8-bit character set; WE8MSWIN1252 is 
the true 8-bit character set for Oracle, and should be specified for any Oracle 
EAS database as the character set. The default character set for SQL Server 
(SQL_Latin1_General_CP1_CI_AS) is a true 8-bit character set.  

Conversion may also be required if the EAS server’s host OS has an Asian 
native default character set such as Japanese or Chinese.  

If required, complete the following:  

1. Back up your database. 

2. Run the installers for the products you are upgrading. 

3. Run the DB Update Scripts to bring your database up to latest applicable 
version.   
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The Unicode conversion script should only be run on environments that 
are version 6.2.0 or higher.  Run one of the following upgrade scripts on 
the EAS database: 

 mssql_unicode_conversion.sql for MSSQL databases 

 oracle_conversion.sql for Oracle databases 
4. Start EAS Administrator and click Tools > Database Conversion. 

IMPORTANT! If you are using a database using NVARCHAR fields, ensure that 
after the conversion the following setting has been added to eas.ini under 
the [EAS_SERVER_DB] section: DatabaseUseU16Insert=1. If you create 
a new Unicode database using the Unicode create script, you must set this 
parameter manually. 
 

Oracle Conversion Notes 
EAS inserts Unicode string literals into the database. The Oracle database 
attempts to convert these to the local database character set on the client and 
(database) server. If the character being inserted is not a member, data loss 
will occur.  

To ensure this does not happen, it is required that the client environment 
variable ORA_NACHAR_LITERAL_REPLACE be set to true.  

This conversion is only supported on 10g R2 and later.  

Note: The database conversion may invalidate the indexes. After conversion, 
check the database for invalid indexes and rebuild them. 
 

Upgrade to EAS 6.4 from EAS 5.x 
Before upgrading to EAS 6.4.1, you must be running EAS 6.0 or EAS 6.1.x. 

For instructions on upgrading from EAS 5.x to 6.0, see Upgrade to EAS 6 from 
a previous release (see "Upgrade to EAS 6.0 from a previous release" on page 
44).  
 

Upgrade to EAS 6.0 from a previous release 

Common steps for all products 

Installation setup 
This installation setup procedure applies to EAS for Exchange, EAS for Lotus 
Notes, EAS for Files, and EAS for SharePoint. 
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Successful installation of Autonomy EAS 6.0 consists of the following steps: 

1. Back up your Autonomy EAS database and Autonomy EAS document 
stores before you begin the upgrade process. 

2. Download and run EASSetup.exe. This executable installs the EAS Auto-
setup tool and downloads most other EAS installers that are run manually. 
The default location for the downloaded files is C:\Program Files\ZANTAZ.  

3. On the last pane of the EASSetup installer, enable Show EAS Auto-
Setup Window and click Finish. 

The EAS Auto-setup tool opens and displays shortcuts for installing 
several EAS products. 

4. Install EAS products requiring upgrade by clicking the shortcuts on the 
EAS Auto-setup tool or by running individual installers directly from the 
installation location. The installer names and locations, as well as 
references to detailed installation procedures in product documentation, 
are provided in the product-specific sections that follow.  

Note: The EAS database must be upgraded for EAS 6.0. The database is 
upgraded as part of installation of the EAS server. See Upgrade the EAS 
database (on page 45) for more information.  

5. Follow specific installation and upgrade steps for the product you are 
installing. 

 Upgrading EAS for Lotus Notes (see "Upgrade EAS for Lotus Notes" on 
page 46) 

 Upgrading EAS for Exchange (see "Upgrade EAS for Exchange" on 
page 50)  

 Upgrading EAS for Files (see "Upgrade EAS for Files" on page 56) 

 Upgrading EAS for SharePoint (see "Upgrade EAS for SharePoint" on 
page 57)   

 

Upgrade the EAS database 
The EAS database is upgraded as part of the process of installing the EAS 
Server. The installation procedures are fully described in Chapter 3, "Install 
EAS", of the Installation Guide relevant to your installation (EAS for 
Exchange, EAS for Lotus Notes, EAS for Files, or EAS for SharePoint).  

The key steps regarding update of the EAS database are highlighted here. 

As described in the last step of "Installing the EAS Server", you open the 
database configuration wizard: 

7.  Enable the Launch the EAS Configuration Wizard option and click Finish. 
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This step opens the EAS database configuration dialog box. Enter the 
required information as described in the procedure "Configure the EAS 
database". 

Follow the procedure "Configure the EAS database". In the step quoted below 
(the step number varies in each product installation document) you navigate 
to the upgrade directory and select the appropriate script for your database 
upgrade. 

EAS for Exchange: step 8  

EAS for Lotus Notes: step 9   

EAS for Files: step 7  

EAS for SharePoint: step 7  

#   Select one of the following files: 

... 
c:\Program Files\ZANTAZ\EAS\Upgrade from x to x and 
select the appropriate file. 

To upgrade from 5.0 Service Pack 2 (5.0.2), choose this folder: 
UpgradeFrom502To60. 

Notes: The location of the upgrade files may differ if you did not install EAS in 
the default location. If you are upgrading from a version prior to 5.0.2, you must 
first update to 5.0.2 before applying the EAS 6 update script. 

Complete the remainder of the procedure "Configure the EAS database". 
 

Upgrade EAS for Lotus Notes 
Prior to EAS 6.0 upgrade: Ensure all Notes clients installed on end-user 
machines and on the Domino servers are upgraded to either 7.x or 8.x 
(updated and patched), and add the DIIOP subtask to each Domino mail 
server that hosts EAS-enrolled users. 

1. Delete the CD Image of the previous EAS version.  

2. Download and install EAS 6.0 CD Image.  

3. Back up the EAS database, document stores, and eas.ini files.  

4. Shut down each Domino server and, using Add/Remove Programs, 
uninstall the EAS for Domino Server.msi package. Restart each Domino 
server upon completion.  

5. Note of the template design name for each EAS integrated mail template 
in use (for example, copy the names to Notepad. Be sure to include 
names for mail, journal, and iNotes/Forms templates.) You will need these 
to update the new integration templates.  
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6. If you plan to create new customized integration mail templates, back up 
and delete the current templates (and replicas).  

or 

If you plan to upgrade the existing templates, keep the current templates 
in place and refer to the EAS for Notes Installation Guide, Appendix B: 
"Upgrading Mail Templates for EAS 6", for the upgrade procedure.  

7. Set up an uninstall policy or procedure to remove the "EAS Client.msi" 
package from all end-user workstations. 

Note: You will need to set up a new MSI rollout package if EAS for Files is also 
enabled in the environment.  

8. Using a Notes client on the machine where you installed the new CD 
Image, open the eas_60_installer.nsf file. Open each document and 
database/template in turn according to the version of Notes/Domino in use 
and, with each one, perform a File > Database > New Copy action. Save 
the new copies to the main Domino administration server, ensuring 
specific databases go into their proper subdirectories (for example, 
Forms6.nsf must go in the iNotes folder). These are the required 
databases/templates:  

 easadministrator.ntf  

 easoffline.nsf  

 mail templates and "forms" databases, as required   
9. When all desired databases/templates are present, use a Notes 

Administration client to adjust the ACLs appropriately for each, then sign 
them all using either the Domino server's Notes ID or a well-
known/published development/agent-signing Notes ID that has been 
added to end-user ECLs.  

10. Perform the appropriate action to either create a newly customized 
template (refer to the EAS for Notes Installation Guide, Appendix A, 
"Update and Customize the Mail Templates" ), or upgrade the existing one 
(refer to the EAS for Notes Installation Guide,Appendix B, "Upgrading Mail 
Templates for EAS 6").   

Note: The main hidden view that allows EAS to archive each mailbox has 
changed names, so at minimum replace ($NASAdminView) with 
($EASAdminView).  

11. At this point, take the design name from step 5 and add it to the "master 
template design name" of the newly customized/integrated mail template 
and save the change. have the customer's administration team schedule a 
design task to run that evening and update all user mail files.  
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Note: End users MUST run the Upgrade Folder Design action in their Notes 
client after the new template design has been pushed to their mailbox. This 
ensures that the updated design found in the Inbox folder also propagates to 
personal folders. 

12. Upgrade the Notes client on all EAS servers (assuming the prerequisite 
task is complete) to either 6.5.6 or 7.0.1 (or higher in either stream); make 
sure you open the Notes client after upgrading to ensure all updates to the 
workspace and local configuration take place.  

13. Run setp.exe to upgrade the EAS server, EAS Administrator, Storage 
Manager server, and Storage Manager client.  

14. Run the -config utility upon completion of the upgrade and ensure all 
settings are still valid. 

15. On the Database tab, select the appropriate DB update script and execute 
it against the EAS database.  

16. Load the EAS Server and Administrator to ensure all previous settings are 
still valid (check the LDAP settings in particular).  

17. Repeat steps 12-16 on all additional EAS servers in the environment.  

18. Run the EAS IIS.msi package to upgrade all EAS IIS servers, search 
components, and indexer applications in the environment.  

19. Upgrade the Dashboard Server and Agents as appropriate.  

20. Using a Notes Administration client, either upgrade or create a new EAS 
Administration Notes database (easadministrator.nsf) and EAS Offline 
Sync Notes database (easoffline.nsf) according to instructions in the 
EAS for Notes Installation Guide, Chapter 3, section entitled, "Configuring 
the Lotus Domino Server". 

21. Add all active users currently enrolled in EAS to easadministrator.nsf, 
set up appropriate permissions for each, and configure the pointers to the 
EAS IIS server(s) for all.  

22. Replicate easadministrator.nsf and easoffline.nsf to every Domino mail 
server where EAS-enrolled users are hosted.  

23. Update the EAS Search security configuration for users. To do so, in EAS 
Administrator click EAS for Notes > Populate EAS Security Keys. 

Note: All user mail templates must be upgraded to the EAS 6.0 version prior to 
executing this step.  

 

Run the EAS for Lotus Notes installers 
To upgrade EAS for Lotus Notes, install the following EAS 6.0 components. 

Each installer automatically: 

 48 Copyright 2013 Autonomy Corporation plc and all its affiliates. All rights reserved. 



 
Upgrade to EAS 6.0 from a previous release  

 saves configured settings 
 uninstalls the previous version 
 installs the new version 

Note: You must upgrade all Lotus Notes mail templates, Forms7.nsf and 
Forms8.nsf as described in the EAS for Lotus Notes Installation Guide, 
Appendix: Upgrading mail templates for EAS. 

Required and Optional Installers 
EAS Server and EAS Storage Manager - REQUIRED 

 Installer Windows Start menu, All Programs > ZANTAZ > EAS Server & EAS 
Storage Manager  

or 

<your EAS install directory>\EAS_CDIMAGE\EASServer\EAS.msi  

 Notes  Install EAS Server and EAS Storage Manager on the same computer 
that hosts the ZANTAZ EAS 5.0 or 5.0.1 Server and EAS 5.0 or 5.0.1 
Storage Manager. 

 This installer is also used to install the EAS Administrator client. 
 For 

details 
see... 

EAS for Lotus Notes Installation Guide, Install EAS, "Install the EAS Software" 

EAS IIS and EAS Search - REQUIRED 

 Installer Windows Start menu, All Programs > ZANTAZ > EAS IIS & EAS Search  

or 

<your EAS install directory>\EAS_CDIMAGE\WebServer\EAS IIS.msi 

 Notes  The default value of the WildcardPrefix field (Web section of eas.ini 
file) has been changed from 1 to 0. This permits use of wildcards. 
For more information, see easwebsearch.dll. 

 For 
details 
see... 

EAS for Lotus Notes Installation Guide, Install Retrieval Components, "Install 
EAS IIS" 

Dashboard Server - OPTIONAL 

 Installer Windows Start menu, All Programs > ZANTAZ > EAS Dashboard 
Server 

or 

<your EAS install 
directory>\EAS_CDIMAGE\Dashboard\Dashboard_Server_Setup.exe 

 For 
details 
see... 

EAS Dashboard, EAS Dashboard Installation, "Install the EAS Dashboard 
Server" 

Dashboard Agents - OPTIONAL 
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Required and Optional Installers 
 Installer <your EAS install 

directory>\EAS_CDIMAGE\Dashboard\Dashboard_Agent_Setup.exe 

 Notes A Dashboard agent can be installed on the EAS Server/ Storage Manager 
machine during installation of the EAS Server. 

 For 
details 
see... 

EAS Dashboard, EAS Dashboard Installation, "Install the EAS Dashboard 
Agent" 

 
 

Upgrade EAS for Exchange 
Upgrading to the EAS 6.0 version of EAS for Exchange involves the following 
steps: 

1. Ensure that your environment meets the system requirements for installing 
this product. 

2. Download and set up the EAS 6.0 installers as described in Installation 
setup (on page 44). 

3. Install required and optional components as outlined in Run the EAS for 
Exchange installers (on page 51). You will need the EAS for Exchange 
Installation Guide for full installation details referred to from this high-level 
procedure.  

Note: The EAS database must be upgraded for EAS 6.0. The database is 
upgraded as part of installation of the EAS server. See Upgrade the EAS 
database (on page 45) for more information.  

4. If LDAP was not configured for a previous EAS release, or if you are 
installing EAS for Exchange for the first time, you must perform LDAP 
configuration (on page 51). 

5. If upgrading from a previous EAS installation, Map EAS user IDs to Active 
Directory objectGUID attributes (on page 54). 

6. When you have installed all server and client components, you must 
Enable EAS icons in Outlook clients (see "Enable EAS forms in Outlook 
clients" on page 54). 

7. (Optional) To run the EAS Server as a service, or to reset it if you had it 
running as a service previously, execute the following command: 

 <InstallDir>\zantaz\eas\eassrvr.exe -i 
When all of these steps are completed, Autonomy EAS 6 is ready to run. 
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LDAP configuration 
EAS for Exchange requires that an LDAP connection be available on the EAS 
parent server.   

If LDAP settings were configured on the EAS parent server for an earlier EAS 
release, configuration settings are retained upon installation of EAS 6.0 or 
higher. 

If LDAP was not configured for a previous EAS release, or if you are installing 
EAS for Exchange for the first time, the following error message is displayed 
when you attempt to start the EAS server: 

Establishing LDAP connection for ObjectGUID lookup has failed. You must 
properly configure the Exchange LDAP settings under the "Parent 
Specific" tab of the options screen and restart the parent server before 
running any tasks or performing other operations. 

The parent server will start, but you must immediately configure the LDAP 
settings as follows: 

1. From the Windows Start menu click Programs > ZANTAZ > EAS 
Administrator. 

2. Click Settings > Options > Parent Specific. 

3. In the Exchange LDAP Settings section, enter the following information: 

 Default LDAP Container - For example LDAP://T1-ZANTAZ. 

 LDAP User Name - Must be domain-qualified (for example 
mydomain\adminname). If this field is left blank, LDAP defaults to the 
Exchange profile configured for EAS (usually EASAdmin) which 
typically has rights for LDAP. 

 LDAP User Password 
4. Enter the same information on the View tab. 

5. Click OK to save the changes.   
 

Run the EAS for Exchange installers 
Run the installers indicated in the following table to install EAS 6.0 
components. 

Except where noted, each installer automatically: 

 saves configured settings 
 uninstalls the previous version 
 installs the new version 

Required and Optional Installers 
EAS Server and EAS Storage Manager - REQUIRED 
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Required and Optional Installers 
 Installer Windows Start menu, All Programs > ZANTAZ > EAS Server & EAS 

Storage Manager  

or 

<your EAS install directory>\EAS_CDIMAGE\EASServer\EAS.msi  

 Notes  Install EAS Server and EAS Storage Manager on the same computer 
that hosts the ZANTAZ EAS 5.0 or 5.0.1 Server and EAS 5.0 or 5.0.1 
Storage Manager. 

 This installer is also used to install the EAS Administrator client and 
a Dashboard Agent. 

 The EAS database must be upgraded for EAS 6.0. The database is 
upgraded as part of installation of the EAS server. See Upgrade the 
EAS database (on page 45) for more information.  

 The EAS for Exchange hidden option Save SIS Info to Msgs is now 
disabled by default. Prior to EAS 6.0, it was enabled by default. 

 For 
details 
see... 

EAS for Exchange Installation Guide, Install EAS, "Install the EAS Software" 

EAS IIS and EAS Search - REQUIRED 

 Installer Windows Start menu, All Programs > ZANTAZ > EAS IIS & EAS Search  

or 

<your EAS install directory>\EAS_CDIMAGE\WebServer\EAS IIS.msi 

 Notes  The default value of the WildcardPrefix field (Web section of eas.ini 
file) has been changed from 1 to 0. This permits use of wildcards. 
For more information, see easwebsearch.dll.  

 For 
details 
see... 

EAS for Exchange Installation Guide, Install Retrieval Components, "Install EAS 
IIS" 

EAS Outlook client - REQUIRED 

 Installer Windows Start menu, All Programs > ZANTAZ > EAS Clients  

or 

<your EAS install directory>\EAS_CDIMAGE\EAS Clients\EAS Client.msi 

 For 
details 
see... 

EAS for Exchange Installation Guide, Configuring User Client Software, "Install 
EAS client software" (individual or rollout) 

EAS Web Access - OPTIONAL 

 Installer <your EAS install directory>\EAS_CDIMAGE\EASEWA\EASEWA.msi 

 For 
details 
see... 

EAS Web Access Administration Guide, Install EAS Web Access, "Installing 
EAS Web Access" 
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Required and Optional Installers 
EAS Web Access in Outlook Web Access - OPTIONAL 

 Installer <your EAS install directory>\EAS_CDIMAGE\EASEWA\EWAOWA.msi 

 Notes EAS OWA must be manually uninstalled. Note all configured settings. They will 
need to be reapplied to the new installation. 

 For 
details 
see... 

EAS Web Access Administration Guide, Manage EAS Web Access, "Integrating 
EAS Web Access with Outlook" 

EAS Entourage Client - OPTIONAL 

 Installer <your EAS install directory>\EAS_CDIMAGE\EASEEC\ZANTAZEEC.msi 

 For 
details 
see... 

EAS Entourage Client Administration Guide, Installing the EEC server 
components 

Active Directory Plug-in - OPTIONAL 

 Installer <your EAS install directory>\EAS_CDIMAGE\EASUtils\EAS Active Directory 
Plug In.msi 

 For 
details 
see... 

EAS Installation Guide (Exchange, Lotus Notes, Files, and SharePoint 
versions), Install EAS, "Installing the Active Directory Snap-in" 

Dashboard Server - OPTIONAL 

 Installer Windows Start menu, All Programs > ZANTAZ > EAS Dashboard 
Server 

or 

<your EAS install 
directory>\EAS_CDIMAGE\Dashboard\Dashboard_Server_Setup.exe 

 For 
details 
see... 

EAS Dashboard, EAS Dashboard Installation, "Install the EAS Dashboard 
Server" 

Dashboard Agents - OPTIONAL 

 Installer <your EAS install 
directory>\EAS_CDIMAGE\Dashboard\Dashboard_Agent_Setup.exe 

 Notes A Dashboard agent can be installed on the EAS Server/ Storage Manager 
machine during installation of the EAS Server. 

 For 
details 
see... 

EAS Dashboard, EAS Dashboard Installation, "Install the EAS Dashboard 
Agent" 

EAS Management Pack for MOM - OPTIONAL 

 Installer <your EAS install directory>\EAS_CDIMAGE\EASUtils\EASMOM.msi 

 For 
details 
see... 

EAS Management Pack Guide for Microsoft Operations Manager, Install EAS 
Web Access, "Installing the EAS Management Pack" 
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Map EAS user IDs to Active Directory objectGUID attributes 
This procedure applies only to EAS for Exchange. 

Prerequisite: The LDAP settings for the parent EAS server must be 
configured on the computer hosting the parent EAS server. For more 
information, see LDAP configuration (on page 51). 

1. Install EAS 6.0 as outlined in Installation setup (on page 44). 

2. Start the EAS Server. 

3. Launch EAS Administrator and connect to the database and the Exchange 
server. 

4. In EAS Administrator, click EAS for Exchange > Populate Missing 
ObjectGUIDs. 

A window briefly appears while the processing occurs. When the process 
is complete, the OBJECTGUID column of the USERS table in the EAS 
database is populated. 

 

Enable EAS forms in Outlook clients 
To have EAS archiving-related icons (forms) to display beside various items in 
a user's Outlook environment, you must complete this procedure. The EAS 
forms indicate that an item in a user's Outlook client is either archived, 
marked to be archived, or marked not to be archived. For example, this form 

 beside a message in a mail folder indicates that the message is archived 
and the item in the mailbox is actually a shortcut to the message. Other forms 
indicate the archive-related status of items such as messages, tasks, contacts 
and so on. 

Note: You can also use this procedure to Install custom forms (on page 55). 

To enable EAS forms in Outlook clients 
1. Open the EAS Configuration dialog box. To do so, type the following 

command at the Windows command prompt: 

eassrvr -config  
2. On the Exchange tab, in the Profile Name field, enter the name of the EAS 

administrator's Outlook profile name. 

3. Click Install Forms. 

The Install Forms dialog box is displayed. It lists all forms in the Forms 
directory of your EAS installation (default location: 
InstallDir\ZANTAZ\EAS\Forms). 
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4. From the list of forms, select those you want to apply and click OK. 
Autonomy recommends that you select all forms in the list. 

The forms are installed in the Personal Forms library of the EAS 
administrator. 

5. In EAS Administrator, click Settings > Options > Exchange and enable 
the Perform Personal Forms Synchronization option. 

 
Autonomy recommends that you keep this option enabled so that the 
archiving-related forms are propagated to new users in your mail 
environment. 

6. To propagate the forms to user mailboxes, you must run an archive task 
for all the users that require the forms. For detailed instructions on 
creating and running an archiving task, refer to "Configuring Tasks" in the 
EAS for Exchange Administration Guide. 

When the forms have been propagated to a user's Outlook client, they 
remain there until another archive task is run against that user with the 
Perform Personal Forms Synchronization option enabled. If you keep this 
option enabled, it ensures that all new users added to archiving tasks will 
have the forms. 

 

Install custom forms 
If you wish to install custom icons (forms) in user's Outlook clients, you can 
propagate them to user mailboxes using the same method used to install the 
standard EAS archiving-related forms. 

To install custom forms 
1. Create a new .cfg file describing a form. 

2. Ensure the Owner key in the .cfg file is ZANTAZ. 

3. Place the .cfg file in the Forms directory of the EAS installation. 

4. Install the forms as described in Enable EAS forms in Outlook clients (on 
page 54). 

Note: To install your custom forms along with the EAS forms, you must 
choose both your new cfg files and the EAS cfg files from the Install Forms 
dialog box. If you select only your custom forms, the EAS forms (or any other 
forms not selected) will be removed from Outlook clients. 
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Upgrade EAS for Files 
Upgrading to the EAS 6.0 version of EAS for Files involves the following 
steps: 

1. Ensure that your environment meets the system requirements for installing 
this product. 

2. Download and set up the EAS 6.0 installers as described in Installation 
setup (on page 44). 

3. Install required and optional components as outlined in Run the EAS for 
Files installers (on page 56). You will need the EAS for Files Installation 
Guide for full installation details referred to from this high-level procedure.  

Note: The EAS database must be upgraded for EAS 6.4. The database is 
upgraded as part of installation of the EAS server. See Upgrade the EAS 
database (on page 45) for more information.  

4. (Optional) To run the EAS Server as a service, or to reset it if you had it 
running as a service previously, execute the following command: 

 <InstallDir>\zantaz\eas\eassrvr.exe -i 
When all of these steps are completed, Autonomy EAS 6.0 is ready to run. 
 

Run the EAS for Files installers 
Run the installers indicated in the following table to install EAS 6.0 
components.  

Each installer automatically: 

 saves configured settings 
 uninstalls the previous version 
 installs the new version 

Required and Optional Installers 
EAS Server and EAS Storage Manager - REQUIRED 

 Installer Windows Start menu, All Programs > ZANTAZ > EAS Server & EAS 
Storage Manager  

or 

<your EAS install directory>\EAS_CDIMAGE\EASServer\EAS.msi  

 Notes  Install EAS Server and EAS Storage Manager on the same computer 
that hosts the Autonomy EAS 5.0 or 5.0.1 Server and EAS 5.0 or 
5.0.1 Storage Manager. 

 This installer is also used to install the EAS Administrator client and 
a Dashboard Agent. 
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Required and Optional Installers 
 The EAS database must be upgraded for EAS 6.0. The database is 

upgraded as part of installation of the EAS server. See Upgrade the 
EAS database (on page 45) for more information.  

 For 
details 
see... 

EAS for Files Installation Guide, Install EAS, "Install the EAS Software" 

EAS IIS and EAS Search - REQUIRED 

 Installer Windows Start menu, All Programs > ZANTAZ > EAS IIS & EAS Search  

or 

<your EAS install directory>\EAS_CDIMAGE\WebServer\EAS IIS.msi 

 Notes  The default value of the WildcardPrefix field (Web section of eas.ini 
file) has been changed from 1 to 0. This permits use of wildcards. 
For more information, see easwebsearch.dll. 

 For 
details 
see... 

EAS for Files Installation Guide, Install Retrieval Components, "Install EAS IIS" 

EAS for Files Search client - REQUIRED 

 Installer Windows Start menu, All Programs > ZANTAZ > EAS Clients  

or 

<your EAS install directory>\EAS_CDIMAGE\EAS Clients\EAS Client.msi 

 Notes The EAS for Files Search client requires easwebsearch.dll 6.0.0.1232 or higher. 

 For 
details 
see... 

EAS for Files Installation Guide, Client Software, Configuring User Client 
Software, "Install EAS client software" (individual or rollout) 

 
 

Upgrade EAS for SharePoint 
Upgrading to the EAS 6.0 version of EAS for SharePoint involves the 
following steps: 

1. Ensure that your environment meets the system requirements for installing 
this product. 

2. Download and set up the EAS 6.0 installers as described in Installation 
setup (on page 44). 

3. Install required and optional components as outlined in Run the EAS for 
SharePoint installers (on page 58). You will need the EAS for SharePoint 
Installation Guide for full installation details referred to from this high-level 
procedure.  
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Note: The EAS database must be upgraded for EAS 6.0. The database is 
upgraded as part of installation of the EAS server. See Upgrade the EAS 
database (on page 45) for more information.  

4. (Optional) To run the EAS Server as a service, or to reset it if you had it 
running as a service previously, execute the following command: 

 <InstallDir>\zantaz\eas\eassrvr.exe -i 
When all of these steps are completed, Autonomy EAS 6.0 is ready to run. 
 

Run the EAS for SharePoint installers 
Run the installers indicated in the following table to install EAS 6.0 
components.  

Each installer automatically: 

 saves configured settings 
 uninstalls the previous version 
 installs the new version 

Note: For EAS for SharePoint installations to be upgraded, the upgrade 
requires that the files of the previous version first be manually uninstalled.  
When this is completed, the installation of the EAS 6.0 version is safe to 
proceed. 

Required and Optional Installers 
EAS Server and EAS Storage Manager - REQUIRED 

 Installer Windows Start menu, All Programs > ZANTAZ > EAS Server & EAS 
Storage Manager  

or 

<your EAS install directory>\EAS_CDIMAGE\EASServer\EAS.msi  

 Notes  Install upgrades of EAS Server and EAS Storage Manager on the 
same computer that hosts the ZANTAZ EAS 5.0 or 5.0.1 Server and 
EAS 5.0 or 5.0.1 Storage Manager. 

 This installer is also used to install the EAS Administrator client. 
 The EAS database must be upgraded for EAS 6.0. The database is 

upgraded as part of installation of the EAS server. See Upgrade the 
EAS database (on page 45) for more information.  

 For 
details 
see... 

EAS for SharePoint Installation Guide, Install EAS, "Install the EAS Software" 

EAS IIS and EAS Search - REQUIRED 
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Required and Optional Installers 
 Installer Windows Start menu, All Programs > ZANTAZ > EAS IIS & EAS Search  

or 

<your EAS install directory>\EAS_CDIMAGE\WebServer\EAS IIS.msi 

 Notes Installs EAS IIS, EAS Search and EAS Indexer. 

 For 
details 
see... 

EAS for SharePoint Installation Guide, Install Retrieval Components, "Install 
EAS IIS" 

EAS for SharePoint filter - OPTIONAL 

 Installer <your EAS install directory>\EAS_CDIMAGE\EAS for SharePoint\EASSPS.msi 

 Notes The EAS filter enables retrieval of SharePoint content when EAS stubs are 
created for your SharePoint content. 

 For 
details 
see... 

EAS for SharePoint Installation Guide, Install EAS, "Install and configure the 
EAS filter".  
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